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[bookmark: _GoBack]ESSENTIAL OUTCOMES

5. Apply formulas with the Formula tab feature in Excel by:
a) Analyze skills sets provided in the Home tab handout (Writing a Formula, Correcting formulas, Multiple IF Statements, Function Library ribbon, and Defined Names ribbon,).
b) Apply various skill set features presented in the individual ribbons. To find these skills, use the Bookmark feature.
c) Achieve industry-recognized certification, learn the computing skills companies are seeking, boost workforce resume, differentiate student from other applicants, gain valuable experience and confidence, heighten earning potential, and prepare for a successful future.
d) Apply terms in the chapter with application.


The Focus

In Chapter 5, the focus will be on learning the skill sets that are provided underneath each of the toolbar sections for the Formulas tab. The focus will be on the skills sets that you need to know for certification in Microsoft Excel 2016.  There are four sections listed under the Formulas tab.  They are as follows:

1. Function Library
2. Defined Names
3. Formula Auditing (not covered in Chapter)
4. [image: ]Calculation (not covered in Chapter)


Background on Functions 

What is a function? A function is a formula that performs a certain type of calculation that results in a single value. Excel allows you to write your own formulas as well as correct formulas. Excel also has available for your use preformatted formulas to determine various types of results. In this section, it is important to know when to use the AutoSum feature and when to use the Insert Function Icon.

[bookmark: _Writing_a_Formula]
[bookmark: _Correcting_Formulas]Correcting Formulas

In the MOS test, you will be asked to review a formula and correct it. You will now have exercises where you will have to look at a formula and analyze it to determine how to correct the formula. To do this, use the following criteria:

a) Read the directions carefully.
b) When you are asked to change a formula, they are NOT asking you to rewrite the formula. Rather, they are asking you to review the written formula and then make some small change in the formula so that the formula will get the results requested. So, DO NOT rewrite the formula.
c) Before changing any part of a formula, review the column and/or headings involved in the formula.
d) Once you analyze the formula, ask the following question: What results does the present formula presently get?
e) Once you know what the formula presently does, then ask the question, “What results do I actually want?”
f) Then determine what small change you need to make in the present formula to get the results you want.
[image: ]

[image: ][image: ]Insert Function Library

The Insert Function Library icon opens an Insert Function dialog box. This box offers various possibilities such as search for a function or select a function (see image to the right).
[image: ]For the MOS certification exam, you will need to know how to use the functions such as the COUNTIF, the IF statement, CONCATENATE , PROPER, LEFT and more. The most important skill to have here is to basically know how to follow the directions that are given on each box that is open for each function.

For example, if you open the VLOOKUP Function dialog box (see image to the right), you will see four boxes. When you click on each box, the box provides an explanation or direction for that specific box below (see read box). Learn to use these directions while creating formulas, and you will have better success on the MOS test when you must create a formula that you might not know.


[bookmark: _Function_Library_Ribbon][image: ]Function Library Ribbon

On the Function Library ribbon contains nine different icons. These icons are designed according to categories. If you know the category, it is easy to find the preformatted formula that you seek. The nine categories are as follows:

· AutoSum: automatically adds up totals, averages, maximum, minimum, etc.
· Recently Used: displays functions that you have recently used.
· [image: ]Financial: inserts financial functions such as PMT and PV.
· Logical: adds logical functions such as “IF” statements.
· Text: add a text function.
· Date & Time: add a time functions.
· Lookup & References: adds lookup and reference functions. 
· Math & Trig: adds mathematical and trigonometry functions.
· More Functions: if you do not see what you need, this function allows you to browse for more functions from categories like statistical, engineering, web, or OLAP cube functions (see image to right).


ALTERNATIVE INSERT FUNCTION, FORMULA BAR AND NAME BOX
[image: ]
When you are writing formulas, you need to know the purpose of the alternative function box, the formula bar and the name box.

NAME BOX:  This box allows you to see what cell you are in. When you click on the drop-down box to the left of the cell name, you can also retrieve the names of tables and other items within the worksheet.


FORMULA BAR: This bar allows you to see a formula as well as to see the formula in case you need to make a correction in the formula.

ALTERNATIVE INSERT FUNCTION: This function can is used in two different ways: first, it is a short-cut for opening up in the Insert Function box. Second, it allows you to write a formula. Here are two examples for using the Alternative Function box to aid in writing a formula:
PROPER FUNCTION: 

[image: ]In the example on the right, we want to have the first name of each Employee appear in the “Name” column, left-aligned. Instead of copying and pasting, we can write a formula that will do this quickly.

In the Formula Bar, do the following:

1. Place your cursor in the cell where you want the answer to be placed (Name column). Type in the “=” sign in the formula bar.
2. In all caps, type in “PROPER”. This function works with proper names.
3. Hit the “Tab” key once. This will insert a “Left Parenthesis” following the word, “PROPER”.
4. Then Select the Alternative Insert Function box (fx).
5. [image: ]You will then be prompted to insert the required “Text”. Click on the first employee cell and then hit “Enter” (see diagram below). Then click on “Ok”.
[image: ]
The results are as follows (see image to right)

NOTE: when you are using this function, if you make a mistake, you might get an error message when rewriting the formula. Just save your work, exit out of the document, and the reopen the worksheet.


[image: ]THE LEFT FUNCTION:

The Left Function allows us to create abbreviations for words in one column and create a new column with a character code. 

In the example to the right, we want to write a “two-code abbreviation for the words in the “Style” column. 

To do this, use the following formula:

1. Place your cursor in the cell where you want the answer to be placed.
2. In that cell, type in the “ = “ sign.
3. In all caps, type in the word, “LEFT” and then hit the “Tab” key once.
4. Then select the “fx” to the left of the formula bar and the alternative Insert Function box will open.
5. In the Text area, click on the first cell that is housing the word, “Sedan”.
6. In the Num_Chars box, type in “2” (since we only want two characters).
7. [image: ]Hit Ok.
[image: ]
The results will be placed inside the cell (see image below).

NOTE: if you wanted the character code to be four letters long, just type in “4” instead of “2”.




[bookmark: averageif]AVERAGEIF FUNCTION

Returns the average (arithmetic mean) of all the cells in a range that meet a given criteria. The AVERAGEIF function syntax has the following arguments:

· Range:  Required. One or more cells to average, including numbers or names, arrays, or references that contain numbers.
· Criteria:  Required. The criteria in the form of a number, expression, cell reference, or text that defines which cells are averaged. For example, criteria can be expressed as 32, "32", ">32", "apples", or B4.
· Average_range:  Optional. The actual set of cells to average. If omitted, range is used.

To use the averageif function, do the following:

1. Place your cursor in the cell where you want the formula to be placed
2. In the formula bar, type in “=averageif” and then hit the tab key.
3. Click on the “fx” (function) key to the right of the formula bar. The averageif function box will open.
4. Select the specific data need for the formula.
5. Click Ok.



[bookmark: SUMIF]SUMIF FUNCTION

You use the SUMIF function to sum the values in a range that meet criteria that you specify. For example, suppose that in a column that contains numbers, you want to sum only the values that are larger than 5. You can use the following formula: =SUMIF(B2:B25,">5").

The SUMIF function syntax has the following arguments:

· rangel  Required. The range of cells that you want evaluated by criteria. Cells in each range must be numbers or names, arrays, or references that contain numbers. Blank and text values are ignored. The selected range may contain dates in standard Excel format (examples below).

· criteria: Required. The criteria in the form of a number, expression, a cell reference, text, or a function that defines which cells will be added. For example, criteria can be expressed as 32, ">32", B5, "32", "apples", or TODAY().

[bookmark: _Writing_Own_Formulas][bookmark: _Using_the_Insert]
[bookmark: _COUNTIF_FUNCTION:][bookmark: _COUNTIF_FUNCTION][bookmark: CountIfFunction][image: ]COUNTIF FUNCTION

The COUNTIF function counts the number of cells within a range that meets the given criteria.

Since I do not know where the COUNTIF function is, I would open the Insert Function dialog box and in the Search for a function” box, type in “CountIf” (see image to left). The Search will produce the following results (see image to the left). Then select the COUNTIF option.

To use the COUNTIF function:

1. Place your cursor in the cell where you want the results to be placed.
2. Click on the “Insert Function” icon and search for the COUNTIF functions.
3. Then select the function, “COUNTIF”.
4. [image: ]When the Function Arguments dialog box opens, select the range of cells that you want to count. This range will be placed in the “Range box.” NOTE: remember to review the directions give (see red box).
5. [image: ]Move your cursor (by tabbing or clicking) to the “Criteria box”.  The Criteria is the condition in the form of a number, expression or text that defines which cells will be counted.  For example, we want to count the cell range, D5:D10, for any criteria that exceed 10.  “Exceeds” indicates that we are looking for any value that is > (greater than) the number 10.  Thus, we would key in the Criteria box, “>10” (you do not need to type in the quotations—Excel will automatically put these in for you).
6. Click OK and the results will be inserted into the cell that houses your cursor.

[bookmark: _CONCATENATE_FUNCTION][bookmark: ConcatenateFunction]DATE FORMULA

You can write a formula to determine dates. For example, if you have a beginning date, and you know the terms, you can write the formula. Just use the date cell + the number of days. 

CONCATENATE FUNCTION

[image: ]The Concatenate function is used when you have two different strings that you want to join together into one. For example, if you look at the diagram to the left, we have two different strings (Column A and Column B). Since the first and last names are in different columns they are referred to as strings because they are related information. Even though having this information is beneficial, we also may want to join these two strings into one string for specific purposes. This is easy to do using the Concatenate Function.  

1. [image: ]The first step is to create a new column.  We will do this by inserting a C column following Column B. This way we will have the full name right after the Last Name string.
2. Place your cursor in the cell where you want the two strings joined together. In this case, we would be our cursor in C5 (see diagram to the right).
3. Then select the Insert Function icon and search for the Concatenate Function.
4. [image: ]Then select the Concatenate Function and the Function Argument box will open.
5. We now need to record the condition for this function:
a. In the Text1box:  select the “Last Name” and hit the “Tab” key
b. [image: ]In the Text2 box:  insert a “comma” followed by one space using the space bar.
c. In the Text3 box:  select the “First Name” and click on, OK.
d. If correct, just use the fill handle to copy the formula to the remaining cells in column C.

The results are given in the image on the right. Column C shows the last name first, followed by a comma and a space and then the first name. 



IF FUNCTION

[image: ]The IF function is a logical test that checks to see whether a condition is met, and returns one value that is true and one value that is false. For example, you are working with test scores. You want to have all test scores that are over 70% to have the word “True” written. If they are under 70%, you want the word “False”.

You will find the IF function icon underneath the “Logical” icon under the Functions Library toolbar ribbon. The IF function is a logical argument used to create formulas.

The IF function will provide the ability to write a formula, then tell the formula what you want done if the value is true or whether the value is false. Besides words, you may also use letters, such as A, B, C. 

[image: ]There are three parts that you will need to complete to create logical, accurate formula. Before creating our formula, we must first establish the “condition” or the “logical test.”

Condition:  A condition is the logical test that we want to create to check whether a condition is met or not met. The logical-test is any value or expression that can be evaluated to True or False.

[image: ]For example, in F5, we want to identity a condition that will insert the word “Blue” for all test scores greater than 89% (True) and the word, “Red” (False) for test scores that are less than 90%. NOTE: when using the IF function argument, you do not need to type in the equal sign...it is assumed.

1. In the Logical Test box: Click on B3 followed by the greater than sign (>) and 89%.
2. [image: ]In the Value if True:  we would type in the word, Blue, for the true results that we want  (you do not need to add the quotation marks; Excel will automatically do this for you).
3. Value if False:  we would type in, “Red,” for the false value that we do not want.
4. Click on Ok.
5. In the formula bar, check the formula to make sure it is measuring the results that you want.
6. If you want to add color to the results, you may do so.
7. [image: ]Then use the fill handle to drag the results to the remaining cells in column E.

Looking at the final results in the image on the previous page, the color “blue” and “red” were added after determining that the formulas was correct. Notice that for all test scores over 89%, they have the word, “blue”, and for all test scores under 90%, have the word, “red.” If you look in the formula bar, you will see the formula that was created to retrieve the results that we wanted.

[bookmark: MultipleIfFunctions]Writing Multiple IF Statements

In the example above, the IF function provided us with one result that was either True or False.  What happens if you want to show multiple results?

To show multiple results, you will need to write an IF statement in the cell to obtain the results that you want rather than the preformatted IF Function. For example, you want to put a grade (A, B, C, D, F) in a cell that corresponds with the average percent. So, where do we start?

1) We start with the results that we want. We want the formula to determine a grade for each of the average percentage for each student. So, we must first determine the break point for each of the grades. The break points are as follows:
a. 92% or above: A
b. 83% to 89%: B
c. 75% to 79%: C
d. 65% to 69%: D
e. Below 65%: F
2) Now to write the formula. Based on step 1, we know there are five possibilities for this formula that needed to be included in the IF statement. Thus, within one formula, we need to provide five possibilities for the IF statement to determine which answer is true and which are false.
3) To write the IF statement, we need to use the average percentages given in Column N.
4) To write an IF statement, you will need:
a. The equal sign at the start of the formula;
b. Followed by the word, IF.
c. Followed by one left parenthesis.
d. Followed by the cell for the average percent
e. Followed by the appropriate mathematical operators
f. Followed by the first percentage grade
g. Followed by a comma.
h. In double quotation marks, you will need to be in the first results (“A”), followed by a comma. The results must always be put between double quotation marks.
i. To get the 2nd and remaining results (“B”, “C”, D”, “F”), you will need to type in the word, “IF”. Then use the same procedures given above.
j. To end the formula, you will need five right parentheses since you have five possible results within one formula.
k. To review the entire formula, see the next page.
l. [image: ]Then, use the fill handle to copy the formula to the remaining cells in the column.  The results are given in the image below.
[image: ]















PMT Function

[image: ]A PMT function is used when you want to know how much your monthly payment would be on a loan based on an interest rate and a constant payment schedule. The PMT function is located under the Financial icon.

[image: ]Let’s say that you are looking to purchase a car and will need to borrow $20,000 from the bank (Loan Amount). The bank will give you a loan at 6.8% interest, paid monthly, and you will have to pay back the loan in 5 years (or 60 months). When we have this type of situation, we can use the PMT function, located under the “Financial “icon to determine how much our monthly payment to the bank will be for the car loan. 

To write the formula:

1. Place your cursor in the cell where you want the results. Go to the “Financial” icon and scroll until you find the PMT function.
2. [image: ]Rate: To complete the PMT launcher box, start with the “Rate”. You will need to take the percentage and divide it by the month for the year.
3. Nper:  Select the cell that contains the number of payments:  60 (for the 5 years).
4. Pv:  Select the cell that contains the amount of the loan. NOTE: make sure add the “minus” mathematical operator at the beginning.
5. [image: ]Hit “Enter.”

The result would be that you would pay to the bank, “$394.14” each month until your car loan is paid off (see image to the right).


PV Function

[image: ]The PV function calculates the present value of a loan or an investment, based on a constant interest rate. You can use PV with either periodic, constant payments (such as a mortgage or other loan), or a future value. You will find the PV function under the “Financial” feature. 

Let’s say that our business provides an annuity plan for our workers. The image on the left provides the information for the workers for each of their annuity plans. 
[image: ]
Using the PV function, we can determine the Future Value of the Annuity when it comes due.

The image to the right shows the process of writing the formula to determine the Future Value of the annuity.

Once you have the Function Arguments box completed, click on OK.
[image: ]Once you have determined the Future Value of the Annuity, use the fill handle to copy the formula down the column. See image to the right.



VLOOKUP Function

VLOOKUP (V stands for vertical) is a database function that allows you to look up information in vertical columns ONLY. VLookkup allows you to look information in a workbook that may be contained in another worksheet in Excel. For example, in the image below, we could look up the price for Washing Machines by using the column A, which is called a “unique identifier.” A unique identifier is a unique column that identifies a specific product, etc. VLookup allows you to use a formula to identify a cell and then use another cell to find the results.

VLookup is very like looking up information in a phone book. You would look up a telephone number based on a person’s first and last name. VLookup follows this same idea.  There are four parts to Vlookup:

1. [image: ]Lookup_Value: In a phone book, the look up value would be a person’s name. In the example to the right, the lookup value would be the Item Code #.  The Lookup value must always be in the first column on the worksheet.
2. In the worksheet to the right, we are in the Sales Invoice worksheet. We want to use the VLookup function to find the product description that is in the Product Database worksheet.  To do this we would:
a. Click in cell “C2” of the Sales Invoice.
b. Go to the Formulas menu tab, and select the, “Lookup & Reference” icon. Scroll down the drop-down menu and select “VLookup.”
c. [image: ]Click on the “Lookup_Value” icon and select cell “A18” in the Sales Invoice worksheet.
3. Table Array: To complete the table array box, we want the entire table in the Product Database worksheet (A1-D7). Click on the “Table_Array” icon and then go to the Product Database worksheet and select cells A2:D7. 
4. Col_index_num:  Now it is time to identify which column you want the search results to appear in.  VLookup does not use Column Headings to determine results. You literally count the columns in the worksheet. In the example on the previous page, the search results are located in column 2 in the Sales Invoice worksheet. So, we need to count over two columns.  Col A is the first column, and Col B is the second column. We want the results to be put in column 2 in the Sales worksheet.

[image: ]











5. Range_lookup: should the lookup value be true or false?  This is determined by whether or not you need an “exact” match or an “approximate” match.  When you need an exact match, the value is always “false”.  In our example above, we want an “exact” match, so the value will be “False.”  (False=Exact Match).  In the example to the right, VLookup has been completed for all four products.
 
[image: ]To add in the Unit Price to Column F, follow the same process.  The only step that will be different is the “Col_Index_num icon.  Instead of “2”, type in “3”.  Check to make sure that the price is correct, and then use autofill to copy the formula to the other products in column F.

For the line total, create a formula that multiples the Unit Price by the Quantity.  Then use the AutoFill feature to copy the formula down the column.

The subtotal at the bottom of the invoice should automatically calculate.  Always check the formula.  Then you need to calculate a total for sales tax (Percent times the Subtotal).  Then the total should automatically calculate.

[image: ]
Defined Name Toolbar Section

The Defined Name toolbar section is a function that allows you to create formulas that contain names. Thus, defined name may be used in formulas in place of cell references (values).
The Defined Name section contains four features:

1. Name Manager:  location where you can add, edit and delete name formulas.
2. Define Name:  allows you to create a name formula
3. Use in Formula:  once you have your formula named, you can use it in a function. 
4. Create from Selection (not covered in this Chapter)

[bookmark: _Name_Manager][bookmark: NameManager]Name Manager

The Name Manager Option allows you to create, edit and delete named formulas already created. It also provides you with the details of each of the named defined.

[image: ]To edit a name:

1) Place the cursor in the column/row heading that you want to edit in the worksheet.
2) Go to the Formulas menu tab and select “Name Manager.”
3) [image: ]Click on the name that you want to edit that is listed in the Name Manager dialog box. In this case, we want to edit the “Quarterly_Payment.
4) Then select “Edit.” (see image to right).
5) Go to “Refer to:” box at the bottom of the Edit Name dialog box and select the up arrow (see image to the right).
[image: ]






6) Once the Edit Name – Refers to: box opens, select the cells in the worksheet that you want included in the formula (see image above).
7) Hit “Enter”.
8) Click “Ok.” Close out the box.





Define Name

[image: ]The Define Name option allows you to create a new formula with a name instead of a cell reference (or value).  In the spreadsheet example to the right, we want to define a name for the Total, Average, Maximum and Minimum instead of using the cell reference as identification.

1. Select “Name Manager”.
2. Click on “New”.
3. In the Name section, type in the name you want to use to define your formula.  In this case, we will type in “Total”.
4. At the bottom of the box, click on the “Refer to:” and then select the range of cells that should be included in the formula.
5. Hit Enter.
6. You should see the formula appear on the box. 
7. Check the Name Manager and you should see it listed.

Once you have created the formula, you will be able to use this formula on any worksheet in your document. This process eliminates the continuous repetition of creating the same formula between worksheets.
[image: ]
Use in Formula

Once you define a name for a formula, you can use this formula when writing a formula. Once you create a named formula (Define Name Manager), the actual named formula will open in the drop-down menu when you click on the “Use in Formula” icon.

If you look at the image to the right, you will see that there are three Defined Name formulas. 

To use these in a formula:

1) Place your cursor in the cell where you want the results placed.
2) In this case, since we want a total, we will click on the AutoSum icon under the Formula menu tab, and select “Totals”.
3) Once you select ‘Totals”, then the “Use in Formula” will be darkened.
4) Click on the drop-down arrow and select the “Defined Name” formula you want to use in the formula.
5) Then hit “Enter”. The results will be placed in the cell selected.
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